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Creating a Simple Reading Assignment in Read:OutLoud

Introduction

SOLO’s Read:OutLoud program can be used to create simple reading assignments for
students who may be struggling with reading comprehension. Rich Text Documents can
be opened in Read:OutLoud and the various text reading and highlighting features can
be used to help students read and understand the text. In this tutorial you will learn how
to:

¢ Create a Rich Text Format (.rtf) document containing curriculum based content
from the internet

¢ Add the document to the Content Management area of Teacher Central

o Create a Read:OutLoud assignment based on that document

Quick Instructions

Locate website with content you wish to use.

Copy the text and paste into Wordpad (or any other word processor).

Save the file as a Rich Text Format (.rtf) in the SOLO “eText” folder on your
hard drive.

Launch SOLO and sign in as “Teacher” (password: school).

Create a new Read:OutLoud Assignment Template.

Add the eText file you saved to your assignment.

Save the Read:OutLoud assignment.

Add an assignment description and assign it to specific students.

Send the Read:OutLoud assignment to Draft:Builder and add questions to the
reading guide.

10. Save the completed Read:OutLoud assignment.
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Tutorial

Read:OutLoud contains text reading and highlighting features which students can use to
help read and understand eText material. Teachers can easily prepare specific reading
assignments, based on curricular content, so students can take advantage of these
program features.

Creating an eText document

Read:OutLoud can display documents that are saved as Rich Text Format (.rtf). These
can be created using any word processing program, including the accessory program
WordPad (Windows) or TextEdit (Macintosh).
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|@ Haida - Microsoft Internet Explorer
1 . Launch your Web File Edit Wiew Favorites Tools  Help

browser and navigate to aweb Qe - () [¥] (@) (b D Sormems @ 2001 & - S
page that Contalns |nf0rmat|on Address f‘i‘]http:,l’;’www.Factmnnster‘com,l’ces,l’sociaty,l’ADBZZSSB.htm\
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u.s. Encyclopedia
2. Click and drag through People
the text you want to capture to
select it.

Haida

Haida (hi'du) [key], Native NMorth americans living primarily on the Queen

Charlotte Islands, off British Columbia, and on the southern end of the
Math & fi) Prince of Wales Island, off alaska. They speak the Haida language,

3_ GO tO the “Edit” menu RETI) which forms a branch of the family of Nadene languages {see Native

“ » Sports American languages). In physical and cultural characteristics they are
?nd Sel”eCt Copy (OR type Cool SEuFf @ closely related to the Tlingit and the Tsimshian; the three tribes helong
Ctrl-C” on your keyboard).

to the Morthwest Coast cultural area {see under Natives, Maorth

Word Wise

Games &

. . . . American). Before the advent (early 19th cent.) of white fur traders,
Duizzes

The teXt IS now Copled |nt0 — the Haida lived in large cedar-plank houses, fished for salmon, and

your Computer’s Cllpboard, PR B 1 tod sea mammals; they were noted for their large and well-made

Fact Monster dugout canoes. Their society was divided into the Raven and Eagle
clans; marriage was always with someone of the oppaosite clan, and clan
membership derived matrilineally. Their customs featured the
conspicuous display of wealth (see potlatch). They then numbered some
8,000, but by 1880 disease, particularly smallpox and venereal
infections, had reduced their population to some 2,000, Today most
Haida are employed in fishing, canning, and logging; many have left their
island homes for mainland life. The artwork of the Haida is widely
acclaimed. In 1990 there were close to 2,000 Haida living in the United
States and another 2,000 in Canada.

See C. Harrison, dAnclient Warriors of the North Pacific {1925); P, Miller,
Lost Heritage of Alaska (1967).

4. Go to your “Start” menu and select “All Programs”. Under “Accessories” select
“WordPad”.

5. When WordPad opens, go to the “Edit” menu and select “Paste” (OR type
“Ctrl-V” on your keyboard). The text will paste into the word processing area. Format
the text as you want (e.g. bold the  Ejiama warwad CoE

t|t|e’ add Spaces, and SO on). File Edit wiew Insert Format Help

DEH SR t#h s @B &
If you want to add more text to the ~ |[lm=henforn ] 2 v] Wesen wiinjsu@Ej== &
document, go back to your internet |8 TR R A
browser, locate the text on a web Haida ;|

page’ SeIeCt It’ Copy It and then Haida (h'dw), Native Morth Americans living primarily on the Queen Charlotte Islands, off British Columbia,

paste |t |nt0 your Open Word Pad and on the southern end of the Prince of Wales Island, off Alaska They speak the Haida language, which
forms a branch of the family of Madene languages. In physical and cultural characteristics they are closely
dOCU ment related to the Thngit and the Tsimshian, the three tnbes belong to the Morthwest Coast cultural area . Before
the advent (eatly 19th cent) of white fur traders, the Haida lived in large cedar-plank houses, fished for
salmon, and hunted sea marmmals; they were noted for their large and well-made dugout cances, Their society

Note: TeXt W|” be pasted was divided into the Raven and Eagle clans, marriage was always with someone of the opposite clan, and clan
. . membership denved matrilineally. Their customs featured the conspicucus display of wealth They then

Wherever yOU I Cursor Is Iocated In tunbered some 8,000, but by 1880 disease, particularly smallpox and venereal infections, had reduced their

the dOCU ment population to some 2,000. Today most Haida are employed in fishing, canning, and logging; many have left

their island homes for mainland lfe. The artwork of the Haida is widely acclaimed. In 1990 there were close
to 2,000 Haida lving it the United States and another 2,000 in Canada.
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If you want to add a graphic to your file, you can paste one in as well.

5. Save your WordPad file by going to the “File” menu and selecting “Save”.

@ Document - WordPad E]@
File Edt ¥iew Insert Format Help

Mew,., Chrl+1 - EB

Open... ChrHO

Save Chrl+s 12 [we| [westem v B 70 S |EE £ =

Save As... [%

2 3 4 5 N '
Print... Chrl+P
-~
Print Preview
Page Setup...

1 ch2+2iread-me

Send...

Exit

Canada.

Saves the active document.

rth Amencans lving pnmanly on the Queen Charlotte Islands, off Braish
thern end of the Prince of Wales Island, off Alaska They speak the Haida

ranch of the family of Madene languages. In physical and cultural characteristics
they are closely related to the Thngtt and the Tsmmshian, the three tnbes belong to the Morthwest Coast
cultural area . Before the advent (early 15th cent.) of white fur traders, the Haida lived in large cedar-plank
houses, fished for salmon, and hunted sea matnmals, they were noted for their large and well-made dugout
canoes. Ther society was dimded into the Eaven and Eagle clans; marnage was always with someone of
the opposite clan, and clan membership derived matrilineally. Their customs featured the conspicuous
display of wealth. They then numbered some 8,000, but by 1880 disease, particularly smallpox and
venereal mfections, had reduced ther population to some 2,000, Today most Haida are employed m
fishing, canning, and logging, many have left their island homes for mainland life. The artwork of the Haida is
widely acclaimed. In 1990 there were close to 2,000 Haida lving in the Tnited States and another 2,000 i

6. When the “Save as...” window opens, type a name for the file in the “File name”
field. Under the “Save as type:” drop down list, save the file as
a “Rich Text Format (RTF)".

7. It is important to save this document
in the SOLO eText folder on your
hard drive. Navigate to that location
by following this path:

C drive

My computer

2
iy Compuer
<

My Metwaork

Once you are inside the eText folder, click the “Save” button to save the file.

iy o
|_Z)5naglt Catale
|23 Files

File: narne:

Save as lype:

File: name:

a3 hype

Haida eText

Rich Text Format [RTF)

Rich Text Format [RTF]
Tewut Document

Tewut Document - MS-DOS Format

Unicode Text Document

SOLO
%\mrdrﬂal

Cantenk
tudents

Content --- eText

eText
utline Te

8. Quit WordPad by clicking the red close box in the upper right corner of the
window.
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Creating the Read:OutLoud Reading Assignment

Now that you’ve saved a Rich Text Format document with text that you want your
students to read, it's time to create the Read:OutLoud reading assignment.

1. Launch SOLO from your “All Programs” list. sesSign In mEx
File Tools Help
2' When the “Sign in” WindOW Opens’ Sign into [ Mew Student. . ] l Teacher Sign In...
SOLO as a “Teacher” by clicking the “Teacher N&
SIQrI in” button. Sart by class: All Students hd
Aaron
3. Select “Teacher” as the User and type in the Jennifer

Teacher password (“school”). Click “OK”.

Teacher Sign In E]
4, Teacher Central will open up. Lser - F—— =
This is the organizational area
Paszword: 0 B essses
where you can manage all
aspects of the SOLO program. New. N | Cancel |

From here you will create the
reading assignment.

Click the “New Assignment Template” button that is located near lxl'“ew Aimpentlennite
the top of the Teacher Central window. a3

5. On the “Create New Assignment” window that opens up, click the “Open a
Blank Assignment Template” button.

#= Create New Assignment

MNew Assignment Template.

Open a BLANK Open a SAVED Open the Reading To

Assignment Template Assignment Template Writing WIZARD
[
6. Start a Read:OutLoud assignment by clicking =l

the “Read:OutLoud” button. =
@ &

Read:Outlotp ead: ot Loud [wilder

®
7. The “Add eText” window will open up and you wite:DutLoud
will see the list of eText files that are available T Fancal

in the eText folder on your hard drive (including
the file you just saved!).
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% Add eText
Select that file by clicking on it chiidiiitices
. “ ” File Date
Once’ and then CIICk OK to Ancient Equpt eText.rf 9/8/2005
s ayp
open it in Read:OutLoud. Hada ofestnt 5/17/2008
Haida Indiams. itf L\i 442042008
Long John eText.tf 9/8/2005
You are now ready to add some  |||LongJohn StanToFinish Tt 8/6/2005
H H H Fainforest eTest.rtf 9/8/2005
questions to the Reading Guide e e
to help your students read and
understand the text.
Preview
- .A.
Haida '

£

Browse

Hatda (h?'ds), Mative MNeorth Amencans living primarily on the Queen Charlotte Isla
Entish Ceolumbia, and on the southern end of the Prince of Wales Island, of Alasks
speak the Haida language, which forms a branch of the family of Iadene languages

w
|

oK ] [ Cancel

Adding Questions to the Reading Guide

The Reading Guide is located to the right of the eText document. When you first make a
Read:OutLoud assignment, the Reading Guide is basically blank. To create a custom
Reading Guide, you must send the assignment to Draft:Builder.

1. Click on the “Send to Draft:Builder” button ——
in the upper left corner of the Read:OutLoud window.

Before Draft:Builder opens up, you will be asked to enter a
description of the assignment. In the field, type a short
description and then click “OK”.

2. The Save Assignment window opens. On this
window, give the assignment a name and select
“‘Assignment” from the drop down “Format”

menu.
@ Save Assignment As...
File name : |Haida
Farmat : Aszighment w
Agzighment

f —E0utling Template I
Azsign o Sy i r T e

Hlg kdt vew Insert Outhng

%@E B EJ 'j ohi

[5end To Draft:Buider (Ctrl+al+D)]

P@ Template Description

guestions.

Fleaze enter a description for your agzignment:

This is a reading assignment an
the Haida. It has a reading guide
with some reading comprehensian

(] 4 %] [ Cancel
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@ assign

3. Now is a good time to assign this assignment to [, o Al Sronre .
students. Click the “Assign to Students” —
button on the window and then click to select i
. . . Kermy
the students you wish to assign it to. O Leamert

O Leamer2

Click “OK” once you've finished selecting the = '
students and then “Save” to finally save the
assignment.

You will be asked if you would like to create a
Co:Writer Topic Dictionary. If you think your [ selctal | [ Deselecta |
students will be using Co:Writer to write about o) o
the assignment, you may choose to create a :
topic dictionary by clicking “Yes”.

4, After a few seconds, Draft:Builder will start up. You can now add questions
or instructions to the Draft:Builder file (also known as the Reading Guide
when attached to a Read:OutLoud assignment).

Add a subtopic that is an instruction for completing the 2w Help

assignment. Click on the “Subtopic” tool on the toolbar and Kol O R X
then type in the instructions (OR with any topic highlighted in ' .
the outline, click “Enter” on your keyboard). Click to activate Dralt Subtopic (Retur)
the subtopic in the outline and type.

Outline M akes Draft
Haida
|Subtop§:
W WY S D ey | Y e W N T A &0 TE W | obe VLS QI | AW s LV TR
Outline MHotes Diraft
THaida

Use the Speak button to listen to the information about Haida. Then use the
yellow highlight tool to highlight the text that answers the questions below.

5. Add questions to the Reading Guide by clicking the “Subtopic” tool on the
toolbar (OR click “Enter” on your keyboard). (NOTE: You can jump back and
forth between Draft:Builder and Read:OutLoud to see what questions you
want to ask by clicking on the programs in your task bar).

Outline Motes Drraft
Haida
Use the Speak button to listen to the information about Haida. Then use the...
Where do the Haida primarily live?
What did the Haida do before the white fur traders arrived?
What were the Haida noted for?
How was their society divided?
What do the Haida mostly do today? {h?
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BEF Urartpuiaer - | reacnerj - |

6. Once you have added all your questions to the [l S e e G T
Reading Guide, click the “Send to Read:OutLoud” %@y s =
button located in the top left corner of the SOLO Ferd To Resdoutond (Cratrm]
window. SRR

A window will pop up informing you that the document has been modified and will be
reloaded. Click “OK”.

You should now see the original eText file on the left and the new Reading Guide on the
right of the window.

| Read:Outloud - [Toacher] - [Haida.asn] [NE

Fle Edt Wiew Igert Cutne Text Speech Tock Window ek [ J0) =
@OOHS M@+ 2L AWIAF 222K Uil v m BT
HadasTettl | Wab PHaida
t[laida Use the Speak bl.mon tn llsFen_to the information about...
Where do the Haida primarily live?
Hauda (h¥'du), Hative Horth AJuc:-.-.:[n: hn;n,- pnn\l[afiy on the Cueen Charlotte Idands, off Brbsh What did the Haida do before the white fur traders arived?
! of the Frnce o

What were the Haida noted for?

How was their society divided?

What do the Haida mostly do today?
M Unassigned Notes

nd, off Aluska They speak the Hada
e farnily of Hadene lngy al

mn large cedar-plank houses, fshed for salwon, and hunted sea mammals; they were neted for thewr large
and well-made dugout cances. Thewr socsety was donded mbe the Eaven and Eagle clans; marmage was
abways with sameane of the apposite clan, and clan membershap derived matmineally Their customs

. us display of wealth, ‘They then nummbered some 3,000, but by 1580 &

ng. ¢ loggg. m ve Ief
ds is widely acclaimned Tn 1990 thers were clo

7. Save your Read:OutLoud assignment by going to the “File” menu and
selecting “Save” (OR clicking “Ctrl — S” on your keyboard). Your reading
assignment is now ready for your students.

Congratulations! You have created a simple reading assignment in SOLO!

Student Completion of the Reading Assignment

The next time your students log into SOLO, they will see that this assignment has been
added to their assignment list. They can launch it from Student Central and begin
completing it.

1. They would begin by clicking on the first subtopic (the instructions) in the
Reading Guide and then clicking the “Speak” button in the toolbar to read the
instructions aloud.

2. They can place their cursor anywhere in the eText document and click
“Speak” to hear it read aloud.
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3. To answer the questions, they would do the following:
A. Click on the question in the reading guide
B. Click and drag through the appropriate text in the eText document
C. Click on the “yellow” highlighter to add that text to the question. Clicking

Window  Help C

on it again will add more information to that particular question.

HETIETRE: g Q-”/ ST A e = TS

Wvellow Highlighter (Alk+%)

icans 1 B fly on the Queen Charlotte Islands, off British

| of'the Wales Island, off &laska. They speak the Haida

the farmly of Madene langnages. In physical and cultural

ted to the Tlingit and the Tsinshian; the three tribes belong to the
fore the advent (early 1%th cent.) of white fur traders, the Haida lived
for salmon, and hunted sea mammals; they were noted for their large
A society was divided into the Raven and Eagle clans, marriage was
tte clan, and clan membership derrved matribineally. Thewr customs

T Haida
Reading Guide with
answers to questions

added. —/— |

Haida
B Use the Speerxbutton to listen to the informati

Where do the Haida primarily live?

What did the Haida do before the white fur tra:
What were the Haida noted for?

How was their society divided?

What do the Haida mostly do today?

~ I Unassigned Notes

Use the Speak button to listen to the information about...
Where do the Haida primarily live?
"on the Queen Charlotte Islands,”
"on the southern end of the Prince of Wales Island, off...
What did the Haida do before the white fur traders arrived?
"lived in large cedar-plank houses, fished for salmon,...
What were the Haida noted for?
"their large and well-made dugout canoes."
How was their society divided?
What do the Haida mostly do today?

~ I Unassigned Notes

4. Students can save their work by going to the “File” menu and selecting
“Save”.

5. They can also print out their work by going to the “File” menu and selecting
“Print”.

NOTE: To see what will be printed before printing, click “Print Preview”. Both the
eText document and the outline list (with answered questions) will be printed.
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“"1 Read:OutLoud

Haida asn.
Drate Wed Mgy 17 2000
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Date - Wed Mgy 17 2006
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Haida
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Seatured the conspicuous displarof weikth, Theythenzraubered soume § 000 bt by 1880 disease,
puticulaly smallpozemnd venereal infections, had reduced theirpopulatimte some 2,000, Todgy most
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United States sl stwther 2 000 &1 Canada.
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[ Previous page

| \ Frint | | Cancel I

Print Preview view eText file

T Haida

Uszethe Speak hutton to listento the
infarmation about Haida Then use the
yellow highlighttool to highliohtthe text
thatanswersthe questions bhelow.
Where do the Haidaprimarily live?

"on the Queen Charlotte Islands"
“on the southernend of the Prince of
Wales Island, off Alaska

‘What did the Haida do before the white fur
traders arrived?

*lived in large cedar-plankhouses, fished
for ealmon, and hunted sea mammals"
What werethe Haidanoted for?
"theirlarge andwellmade dugout
canoes”

Howwas their society divided?

What do the Haida mostly do today?

~ MM Unassignedhiotes

Page 2 of2

Page: 2 Mext
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Reading Guide questions
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